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1. Probe Description

Ta. Spyne scanner

Bending curvature: 150 mm (6 in.) OD to flat
Maximum temperature of operation: 150 °C (300 °F)
Maximum probe speed: 600 mm/s (24 in/s)
Mechanical features:
1. Detachable, high-precision encoder (25.87 count/mm)
. Holder slots for grid-as-you-go markers
. Silicone wheels, easily swappable with magnetic wheels

. Detachable handles

. Detachable keypad

2
3
4
5. Central attachment to the Spyne eddy current array (ECA) probe
6
/. Scan direction

8

. Temperature-resistant PET cable sleeve

Figure 1. Spyne scanner features

3|Page



Eddyfi &
Technologies .S;

Tb. Spyne scanner accessories

Holders for grid-as-you-go markers,
compatible with regular ink Sharpie,
or solid paint markers for high
temperature surfaces such as
Markal’s Quik Stick Mini

Pointer attached to
the front of the
probe, to help
following the grid-as-
you-go marking lines Aluminum tool for
functionality check
and calibration

check (see section

4 of this user guide)

Fischer to Amphenol cable adapter (ADAPT-ENC-
12X18) that allows using the Spyne scanner with an
Ectane

Ten replacement PEEK layers (thickness 0.25
mm, 0.010 in.) for the protection of the Spyne
probes. Always make sure to replace the PEEK
layer on the probe before the PCB itself gets
damaged. More layers can be purchased
directly from Eddyfi.

Set of 16 magnetic wheels for the inspection
of ferromagnetic surfaces, available as an
option with the Spyne scanner. Easily
swappable with the standard silicone wheels.
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Tc. Spyne probes

Probe characteristics:

ECA-SPYNE...
Material to inspect

Topology
Coverage
Coil size
Number of coils
Number of channels
Defect orientation

Max T° of operation

Probe features:

-C-202-250-086 -C-203-250-066

Ferromagnetic,
Ferromagnetic Non-ferromagnetic

(subsurface defects)
Long, single driver Long, single driver

202 mm (8.0 in.) 203 mm (8.0 in.)

4.5 mm 6.0 mm
86 66
126 127

Eddyfi &
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-D-200-250-066

Non-ferromagnetic

(surface defects)

Short, double driver
200 mm (7.9 in.)
6.0 mm
66
128

All orientations (cracks, pittings, etc.)

150 °C (300 °F)

1. High-density connectors to the Spyne scanner

. Central attachment point to the Spyne scanner

2
3. Memory Integrated Circuit (memory IC) for calibration data storage
4

. PEEK tape for wear protection, thickness 0.25 mm (0.010in.)
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1d. Spyne probe replacement

One advantage of the Spyne is the possibility to use different probes with the same
scanner. For example, asingle Spyne scanner can be used to inspect both ferromagnetic
and non-ferromagnetic materials simply by swapping the probes, which takes less than

a minute:

[} Unscrew the encoder, the
keypad and the central
attachment point, and

disconnect the connectors at
both ends.

[I) Turn the Spyne upside
down, open the side doors
and remove the probe.

[ll) Insert the new probe by
placing the side with the
memory IC on the same side
as the scanner cable, and
close the side doors.

IV) Reconnect both probe
connectors and screw the central
attachment point, the keypad
and the encoder back on.
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The terms backstage and frontstage used in this guide refer to the two main windows
of Magnifi. To switch between the backstage and frontstage, click on the triangle icon
at the top left of the screen: Bl © . The backstage is displayed at the opening of Magnifi
and contains the options related to the inspection, data management and general
preferences. The frontstage is the main window for acquisition and analysis.

There are two ways to prepare a setup for a Spyne inspection:

) A customized setup can be generated using the dedicated Spyne setup wizard,
which will guide the user through all the adjustable parameters in order to adapt
it to the inspection specifications.

This setup is generated from the frontstage, by clicking on | new
New = Spyne Setup from the Setup tab in the top ribbon. A
description of all the adjustable setup parameters is provided | 7+ s

in section 2b. %% MPL Surface Setup

7/ Spyne Setup %

II) A generic Spyne setup with default scan parameters can be loaded from the

default setup list of Magnifi located in the backstage, by selecting Open Setup fé
- Default Master List = Spyne, and by selecting the corresponding probe.

Once this default setup has been loaded, all the scan parameters can still be
modified manually from the Setup tab (see section 2b).

All Spyne probes purchased after the release of Magnifi 4.7 in April 2020 have been pre-
calibrated to ensure a uniform response of all their channels, without the need to bring
a large calibration plate to each inspection site. This pre-uniformization is embedded in
the probes and cannot be disabled. It is also specific to each probe and thus unrelated
to the setup being used. In other words, swapping the Spyne probe in the middle of an
inspection will have no effect on data collection: the instrument will always apply a pre-
uniformization that is specific to the probe currently connected.

In versions of Magnifi prior to 4.7, or for probes purchased before April 2020, the pre-
uniformization will not be recognized. Instead, a USB key with a pre-uniformized setup
file was included with the probe.

More information on the pre-calibration process can be found in the datasheet provided
with the probe.
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The Spyne setup wizard will guide the user through 6 steps, which can also be accessed
individually from the Setup tab:

D

Probe

Scan

)

Data

)
Y

Process

Probe selection: Selection of the Spyne probe being used. The probe reference

name is indicated beside the probe connector, under the scanner’s keypad.

Scan definition: Configuration of the scan parameters:

o Scan type (single pass or raster)
o Acquisition type (clock-based or encoder-based)
o Probe speed, acquisition density and acquisition frequency

o Geometry of the scanned area (see section 7)

Data definition: Fine-tuning of the hardware electrical parameters (injected
current’s frequency, amplitude and phase, hardware gain).

Data processing: Adjustment of the C-scan filters:

Indication

L

Display

o Low-pass filter: used to remove high-frequency signals caused by a poor
surface condition, vibrations, electronic noise, etc. A longer window size
will provide a more aggressive filter.

o High-pass median filter: used to remove low-frequency signals caused
by large areas of corrosion, lift-off, changes of magnetic permeability,
etc. A shorter window size will provide a more aggressive filter. See
section 10 for more details on how to use the high-pass median filter.

Indication codes: Managing the different types of indication codes used for
the indications that are added manually to the report.

Display: Configuration of the display options during and after acquisition.
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2c. Setup layout

1.

Axial C-Scan: Visualization of axial indications of crack colonies. In the example
below, 3 axial crack colonies were automatically detected and localized with
yellow boxes in the C-scan. Horizontal white lines spaced by 25.4 mm (1 in) will
help locate these defects on the inspected surface. To display a C-scan without
these lines, switch to the alternative layout display, under the Select menu of the
Layout tab.

Axial Lissajous: Impedance plane for the data points within the axial C-scan cursor.
In the example below, the red horizontal line represents the signal threshold for
automatic detection. Because the signal of the indication inside the cursor gets
above this line, an indication box is automatically added in the axial C-scan.

Transverse C-Scan: Visualization of transverse (circumferential) indications of
crack colonies. In the example below, no transverse crack was detected.

Transverse Lissajous: Impedance plane for the data points within the transverse
C-scan cursor. Since the signal of the indication inside the cursor doesn’t get above
this line, no indication box is added in the transverse C-scan.

[ afr) [t oor Jr oamov |
2 \
1.65V 47.5°
ENEEEDRNENEN
J 1. BREEN [ oor Ji aoov )
: m T
1|4

- \

0.63V 248.9°

- - ENEIEEDRENEN

Figure 3. Spyne setup layout for acquisition and analysis

To change the settings of any of these windows, first select it to highlight its outline in
orange, and go to the Current View tab. To switch a C-scan view between axial and
transverse data, click on the A or T in the top left corner of the window.

By default, the axial indications will only appear in the axial C-scan, and the transverse
indications will only appear in the transverse C-scan. To display the indications in all C-
scans, check the corresponding option in the Analysis section of the Preferences menu.
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This section suggests a convenient way to manage and save automatically large
numbers of data files during an inspection. The following steps can be done in advance
in Magnifi, before getting to the inspection site.

1)

In the backstage of Magnifi, in the Inspection menu, select a project folder and an
inspection folder #6.

In the Acquisition menu, select the Prefix filename option.

Click Create New Ljst.

IV)  Select the prefix for the files name, the number of elements (i.e. data files) in the
list, the index for the first data file and the index increment between each file. The
example below shows an example of list based on the following parameters:

Selected parameters: Resulting list of data files:
Prefix: SCC Prefix Index
Number of elements: 4 SCC 010
Element start number: 10 SCC 012
Element increment: 2 SCC 014

SCC 016

V)  Click Create.

VI)  Switch to the frontstage by clicking on the triangle B in the top left corner of the
screen. If you are starting a new inspection, the acquisition summary window will
immediately pop up and prompt you to enter the information relative to the
current inspection (component type, client, service provider, etc.). This
information can be modified later through the Acquisition summary tab in the
backstage.

VII) In the frontstage, in the Layout tab, make sure the Data bets - button is checked.
The list of data files will be displayed on the left side of the screen.

VIIl) At the bottom of the list of data files, click Acquisition preferences |_'|, and make
sure the following two options are checked:

i)  Automatic file recording
ii)  Automatic Next on Stop Acquisition
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When an acquisition is stopped, these two options will allow to save automatically
the data file and select the next one in the list. The next acquisition can then be
started immediately, without any other action required.

¢4
IX) If an Ectane is being used, connect to the instrument by clicking Connect e in
the Instrument tab.

Setup

X)  Once the setup parameters and preferences are settled, uncheck Setup Mode e
in the Home menu. Otherwise, in setup mode, no data will be saved automatically.

XI) Inthe list of data files, select the first file to be acquired. The inspection can begin.
A few more information about data management in Magnifi:

o) The small icon beside each data file indicates its current state:

Icon Definition
p The data file has not been acquired yet (empty file)
v The data file was acquired and saved, but has not been analyzed yet

The data file was acquired, saved and analyzed, and it was reported
as being free of indications

The data file was acquired, saved and analyzed, and indications
have been reported

“6 @ @ | The data file is tagged for further review

For more information on data analysis, refer to section 9 of this user guide.

o At any time during the inspection, the user can click Add data [+ or Delete

data (%] at the bottom of the list of data files. Data files added with this
button will keep the same prefix, and their index will be incremented by the

number selected in the index menu %2t To create data files with a new
prefix, go back to the backstage and click on Create New List.

o  Tore-scan a data file that has already been acquired and saved, select the

s
data file and click Re-scan . To choose whether the original data file
should be kept or erased, select the corresponding option in Acquisition

3

preferences |
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4. Probe functionality check

At the beginning and end of an inspection, it is good practice to verify that every
channel of the probe is operating properly, to make sure that the inspection results are
valid. The aluminum tool provided with the Spyne can be used for this purpose.

To proceed to the probe functionality check:

1)

Once the probe setup is loaded in Magnifi, click on Cal. Check in the Calibration
tab. The Calibration Check window will open, and some scan parameters (filters
and encoder-based acquisition) will be disabled temporarily to perform the check.

Set the Spyne flat, upside down on a stable surface, with the probe facing up.
Null the probe in this position, and start an acquisition.

Place the nose of the aluminum tool in the long groove, at one end of the scanner,
as displayed in Figure 4. Slide the tool along the length of the ECA probe by
applying pressure on it, to make sure that its nose stays at the bottom of the
groove the whole time. The eddy current sensors will react to the presence of the
aluminum and will produce a characteristic signal in the C-scans.

Figure 4. Probe functionality check with the nose of the aluminum tool inside the long groove.

The aluminum tool is sliding along the entire length of the ECA probe, causing a signal response

from each of the probe’s sensor.

V)

Vi)

Stop the acquisition. Both the axial and transverse C-scans should display a
diagonal signal similar to Figure 5. The orientation of the diagonal line does not
matter: it depends on the direction of the aluminum tool during the acquisition.

Check both the FTA and FIT boxes, and click Check. Two green check marks will
shovv‘ that 'oII axial and troqsverse channels have A
acquired a signal from the aluminum tool, and that no AT
sensor is damaged.
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Figure 5. Example of diagonal-shaped signal obtained from the probe functionality check.

VIl) This data cannot be saved, but a screen capture can be saved with Capture @
This will create a .png file named CalCheck in the current inspection folder.

VIIl) After completing these steps, the Calibration Check window can be closed, which
will reenable the filters and encoder-based acquisition.

Instead of using the aluminum tool, a calibration sample with a long EDM defect can
be used to validate the uniformity of the probe: this is a calibration check. In this case,
stricter settings can be applied to ensure that the signal amplitude and phase of all
channels lie within a certain tolerance that is conform with the inspection procedure
(for example, all channels within 5.0 + 0.5 V.and 60 + 5 °). This can be adjusted in the
Edit Settings menu of the Calibration Check window.

If necessary, the global amplitude and phase of the signal can also be tuned:

8

o To modify the amplitude of the signal, modify the gain in the Data menu
of the Setup tab. This will apply a uniform gain to all channels of the probe.

o  Tomodify the phase of the signal, rotate the signal  |ELH= e

by dragging the rotation button up or down in the
Lissajous window. This will apply a uniform rotation Signal
to all channels of the corresponding C-scan. rotation

Note that if the probe functionality check (or calibration \ button

check) is done after modifying the global amplitude, phase

or eddy current frequency, the tolerance settings may need |

to be modified as explained above, in order to be kept L=l=dclzlt] —L

consistent with the new setup parameters.

13|Page



Eddyfi R
Technologies g:ﬁ

5. Lift-off rotation

The following steps should be performed on the component under examination before
beginning the inspection, to ensure that the phase of the eddy current signal is adjusted
properly. This will help decreasing the inspection noise caused by lift-off and surface
imperfections (i.e. corrosion, paint, dirt...) and will ensure that the defects have an
orientation that will optimize their probability of detection.

)

Click on Lift-off Assist. in the Calibration tab. The Lift-off Assistant window will
open, and some scan parameters (filters and encoder-based acquisition) will be
disabled temporarily to perform the lift-off adjustment. This will also modify the
Lissajous windows temporarily to display the impedance signal of multiple
channels simultaneously.

Put the Spyne on a clean section of the surface under examination. For optimal
results, the surface should be as clean as possible (free of cracks, corrosion...) and
representative of the rest of the surface being inspected. For example, if the entire
surface is coated, the Spyne should be placed on a coating of the same thickness.

With the entire length of the Spyne in good contact with the surface, null the
probe (default keyboard shortcut: F6).

Start an acquisition (default keyboard shortcut: F2).

Slowly lift the probe in the air, and stop the acquisition. If magnetic wheels are
used, start by lifting both extremities of the scanner before lifting the entire body.

1 | 4

Figure 6. Spyne lift-off calibration: 1) Null the Spyne on a clean section of the inspected surface,

with the whole length of the probe in good contact with the surface; 2) Start an acquisition

and slowly lift the probe in the air.
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Figure 7. Positioning of the C-scan cursor at the transition between the material and the air.

VI)  Figure 7 above shows an example of axial C-scan and Lissajous obtained from the
lift-off. Rotate the lift-off signal in order to have the beginning of the impedance
curve pointing toward the left, around 0°, for each channel displayed. Depending
on the amount of lift-off variation expected during the inspection (due to the level
of corrosion, the uneven thickness of the coating, etc.), the curve can be rotated
with its beginning pointing slightly upward, allowing the defect indications to have
a higher phase at high lift-off values. See the example in Figure 8 below.

a) b)

=—

Indication at
~no lift-off

Both indications with
high vertical amplitude

Indication at
2mm lift-off

Figure 8. a) Typical lift-off signal orientation, with the beginning of the curve pointing strictly
to the left; b) Rotation allowing the beginning of the lift-off curve to be oriented slightly
upward; c-d) Typical signal of a crack indication in carbon steel for orientations a) and b)
respectively, showing that orientation b) leads to a higher signal phase (higher vertical
amplitude) that increases the probability of detection of defects at higher lift-off.

VII) This data cannot be saved, but a screen capture can be saved with Capture @
This will create a .png file named LiftOff in the current inspection folder.

VIIl) After completing these steps, the Lift-off Assistant window can be closed, which
will reenable the filters and encoder-based acquisition.
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The Spyne is a high-resolution detection tool that can detect millimeter-sized cracks in
a large variety of materials. Depending on the application, this can lead to hundreds of
indications detected during a single scan.

To facilitate the efficient reporting of large numbers of indications, a lot of efforts have
been put into Magnifi toward the automatic detection of defects. By default, this
automatic detection is based on a vertical signal threshold: indications with a vertical
signal amplitude higher than the threshold will be automatically marked in the C-scan.

The user should keep in mind that the signal amplitude is not affected only by the depth
of the defects. The length, width, orientation and density of the defects will all affect
the signal. For this reason, the Spyne cannot be used for depth measurement.

In the default Spyne setup, the signal threshold is set to 0.50 V. For the probes operating
in single driver (for ferromagnetic materials), this corresponds to the signal of an
isolated 3 mm X1 mm (0.120” X 0.040") crack. For the probes operating in double driver
(for non-ferromagnetic materials), it corresponds to an isolated 2 mm X1 mm (0.080"
X 0.040") crack. Note that these numbers are approximate and will highly depend on
the material type, its magnetic permeability, the geometry of the surface, the level of
corrosion, and the amount of lift-off. For this reason, the signal threshold should be
fine-tuned with a representative calibration sample containing the smallest defect that
needs to be detected.

To adjust the alarm threshold by using a calibration sample with a target defect:
) Perform a lift-off rotation as described in section 5.

I} Null the probe on a clean section of the calibration sample.

) Start an acquisition and scan the target defect.

IV)  Move the C-scan cursor on the target defect in the C-scan corresponding to the
orientation of the defect (axial or transverse). Locate the channel displaying the
highest vertical amplitude by using the up and down arrows while keeping an eye
on the corresponding Lissajous window.

V)  Use either of the following methods to adjust the signal threshold to the desired
level of sensitivity:

a. Select the corresponding Lissajous window (axial or transverse), and enable the
Edit Alarm ‘&) button in the Current View tab. Drag the red horizontal line in
the Lissajous to approximately 75% of the maximum amplitude.

b. With the amplitude measurement set to Absolute Peak Vertical (“Vapv” at the
bottom left corner of the Lissajous window), note the signal amplitude of the
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target defect. Open the Detect Indication window (located in the Setup tab on
Reddy, and in the Advanced tab on Ectane, see Figure 10) and adjust the
corresponding threshold (axial or transverse) at 75% of the measured value.

YR |1| IIBNER 1 oo [1 a00v ]
- BN 0

F1A71

2.27V 50.6°

= —— ENEIEEDRENER

Figure 9. Example of a proper adjustment of the automatic detection signal threshold, using a
calibration sample with a single axial defect.

Detect Indications: Details
Label Based on Source Zone Type Zone
A C-5can FlA el @ Component
Detection Area
Threshold
Boundary

Increase ¥ axis by 12 smpl

Increase ¥ axis by 5 smpl

Figure 10. The Detect Indications window offers the following options; Label: indication name
displayed in the C-scans and in the report; Based on: for Spyne and ECA in general, the
detection is always based on the C-scans; Source: name of the C-scan associated to the
detection (by default, F1A for axial indications and F1T for transverse indications); Zone type
and Zone details: conditions for automatic detection - by default, a simple vertical threshold is
used, but rectangles and quadrants are also available, as presented in the example next page;
Boundary: distance criteria for merging nearby indications - refer to section 9b for more details
on this merging behavior.

VI) Re-scan the target defect multiple times to ensure that it is always detected
automatically. A yellow box will appear around the indication in the C-scan.

VII) If necessary, repeat steps Il through VI for the second C-scan (axial or transverse)
by scanning the same defect with a 90° angle shift.
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For surfaces with major sharp-edged corrosion, a simple signal threshold like the one
presented above may not be sufficient to discriminate corrosion edges from actual
cracks having the same orientation. The example below shows how replacing this
threshold by a quadrant zone can help to separate the two types of indications.

i : B CLEIT = T] Figure 11. a) The left-most

F1A65

g C-scan indication exhibits

............. evsssseesceneeee | SRR i . .the typ|CO| |mped0 nce
signature of a crack, with its

\ orientation at 60°. Since it
crosses the signal threshold,

it is correctly marked as an
axial crack indication in the
C-scan; b) The second left-
1.00V 241.6° . . .
- Ve =EELT == most indication has a
different impedance

O o [

signature, with a hook shape
and a 30° orientation. This is
typically associated with
. sharp-edged corrosion.
Because this indication also
\J crosses the signal threshold,

it is incorrectly marked as an

axial crack in the C-scan; ¢)

The signal threshold has

I EY EE DEEY

been replaced by a quadrant
T 1= 3 O .
: : centered at 60° and with an

aperture of 30°. This allows
the discrimination of the
indications based on their

phase: as shown in the C-
scan, the corrosion is now
dismissed and only the
actual crack indications are
marked as axial defects.

1.90V 30.2°

L) cal | 0 S I I B R

The signal threshold can be replaced by a quadrant by changing the Zone Type in the
Detect Indications menu. The orientation, aperture, inner radius and outer radius can
all be adjusted from this menu or |Label Based on Source Zone Type

manually in the Lissajous. A C-Scan F1A S @
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/. Scan zone definition

Regardless of the surface being inspected, a scan zone should always be defined before
starting an acquisition, to facilitate the tracking of the defects location and to ensure
that the entire surface will be inspected without any remaining unscanned area. This
section of the user guide presents an example of recommended reference scan zone.

The scan zone is defined by the following two parameters:

) The datum reference:

The first parameter to define is the circumferential and axial origin of the scan
zone. For the specific case of a pipe:

o The circumferential origin is typically set on top of the pipe, at 0° (12 o'clock).
A chalk line or measuring tape can be used to draw the 0° line along the whole
length of the pipe. During the first scan, the pointer in front of the Spyne should
be aligned with this line (Figure 12).

o For pipes, the scan direction is typically oriented with the flow. To set the axial
origin, the Spyne should first be placed on the pipe at the start position of the
scan. To ensure that each scan will start at this exact axial position, a full
circumferential line should be drawn aligned with the front of the Spyne.

EDDYFI SpyN;

Figure 12. a) The X and Y datum lines should be defined and marked prior to beginning an
inspection; b) Recommended position of the Spyne at the start of a pipe inspection: the front
of the Spyne is aligned with the axial datum line, and the pointer is aligned with the 0° line.
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Based on the chosen reference datum lines, a series of parameters can be adjusted in
Setup = Scan. The default parameters are the following:

Scan Definition

Configure your scan parameters
Scan: [Single pass vl
Position From: [Enr_oder = |
Density: 2,000 smpl/mm -
Typical Probe Speed: 200.0 mmm/s -
Maximurn Probe Speed:  600.0 mm/s -
Acquisition Rate: 1200 Hz -

Scan foas (X)) Index Asis (%)

Offset: -76.2 mm - 00mm -
Size: 150000 mm o | 2019 mm -
Encoder Preset: 0.0 mm .

Figure 13. Default scan parameters for the probe ECA-SPYNE-C-202-250-086.

o The Scan menu allows switching between single pass scans and raster scans
(see section 8 for more details on these two acquisition modes).

o Position From allows switching between clock- and encoder-based acquisition.

o Density corresponds to the axial resolution (the number of data points
acquired per unit of axial distance).

o Typical and Maximum Probe Speed are based on the user’s preferences.

o The Encoder Preset at the bottom of the screen represents the position of the
axial datum line relatively to what is considered to be the X = 0 position. For
pipelines, the X = 0 reference usually corresponds to the upstream girth weld.
For tank walls inspected vertically, the X = O could be either the floor or ceiling,
depending on the scan direction.

o The Offset refers to the axial (X) and circumferential (Y) start position of the
C-scan. Since the Spyne sensors are located approximately 75 mm (3 in)
behind the front of the scanner, data is always being recorded 75 mm before
the datum reference. If this additional data is of no interest to the user, the
Offset should be set equal to the Encoder Preset to avoid displaying it in the C-
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scan. Otherwise, if the operator is interested to find potential crack indications
immediately behind the datum line, the Offset should be set 75 mm (3 in)
before the Encoder Preset, as it is set by default.

o The Size corresponds to the axial (X) and circumferential (Y, only adjustable
for raster scans) length of the C-scan. It should take into account the actual
scan length and the selected Offset. It is good practice to use a Size value
slightly longer than strictly necessary, to avoid missing data in case the scan

Scan Ais [ X)
Offset: 27.000 in .
Size: 99.000 in -
Encoder Preset: 30.000 in .

Figure 14. In this example, the Spyne
inspection (NDE) begins 30” past the
upstream girth weld: the Encoder
Preset is thus set to 30”. Assuming that
the operator is interested to display the
data recorded by the sensors behind
the start line, the Offset is set 3 inches
before the Encoder Preset, at 27".
Finally, since the C-scan needs to
display all data between 27" and 126",
the Size needs to be set to at least 99”.

II) The overlap width:

The second important parameter to define is the circumferential overlap width
between each scan. It is good practice to use an overlap of at least 10 mm (~ )2 in)
to avoid missing defects between two passes. Without any overlap, every slight
lateral movement of the Spyne during the scan will cause a dead zone in which
defects could be missed.

The overlap width is set relatively to the coverage indicators on the sides of the
probe (Figure 15a). The pointer should be aligned with the beginning of the probe
coverage, and the marker holder should be adjusted to the desired overlap width
(Figure 15b-c). Note that the overlap width will vary with the curvature of the
Spyne. For this reason, the pointer and marker holders should be adjusted only
after setting the Spyne to the correct curvature. Note that instead of using
markers to draw the lines during the scan, chalk lines can be made before
beginning the inspection to ensure a proper overlap.
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1L
Figure 15. a) Four indicators of coverage on the Spyne probes; b) Pointer attached to the front
of the probe and aligned with the beginning of the coverage; c) Marker overlap, adjusted at

the rear of the probe; d) Example of acquisition with an %" overlap, showing that the width of
each pass is equal to the probe coverage (8 in) minus the overlap.
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8. Acquisition

8a. Single pass

By default, the Spyne setup is set to single pass acquisition. In this mode, each axial
scan will be recorded as a separate data file. The only relevant parameter is the scan
length (X-axis), which can be modified in Setup = Scan. With the default resolution of
2 samples/mm (50 samples/inch), the maximum scan length for a single data file is
approximately 50 meters (2000 inches).

If the entire inspection requires more than one pass (more than one data file), markers
or chalk lines should be used to control the overlap between each pass, as explained in
the previous section. The pointer in front of the Spyne should also be used to follow the
line, to ensure a straight axial movement. For a clockwise inspection (2™ pass to the
right of the 1 pass), the marker should be installed on the right side of the Spyne and
the pointer on the left side, as depicted in Figure 16 below:

.
Clockwigs,g(n,_ s
15t pass '

1‘_r
|27 pass

1
0° line

Figure 16. Clockwise scans with the pointer on the left side and the marker on the right side.
The pointer follows the 0° line during the first pass, and follows the lines drawn by the marker
during the subsequent passes.

To perform a single-pass acquisition:

) Null the probe © on a clean section of the component being inspected (as
much as possible free of visible defects, corrosion, etc.)

I) Place the Spyne on its start position (Figure 12)
1) Start the acquisition and roll the Spyne axially along the surface to inspect
V) Stop the acquisition

All these actions can also be performed directly with the Spyne keypad (see section 8c).
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If the maximum scan speed was exceeded during the inspection and data was missed,
black vertical lines will be visible in the C-scan. Without stopping the acquisition, the
Spyne can be rolled back to the area with missed data to remove the black lines.

Depending on the selected acquisition preferences (see section 3 VIII), the next data file
can be selected automatically after stopping the acquisition, to facilitate the efficient
acquisition and recording of multiple data files.

)

3NAGS 14AQQ3
)

Figure 17. Example of a single-pass data file. The height of the C-scan corresponds to the probe
coverage (200 mm or 8 in), with the bottom of the C-scan always corresponding to the cable
side of the Spyne. Horizontal white lines displayed at every inch help to locate the defects on
the surface being inspected.

8b. Raster scan

For disambiguation, the word raster used in this document refers to a unidirectional
scan: once the Spyne has reached the end of its first pass, it needs to be taken off the
inspected surface and brought back to the start line. In this sense, raster scan refers to
a “comb scan”.

To switch between the single pass and raster acquisition modes, go to Setup = Scan.
In raster mode, two parameters become relevant: the scan length in the X-axis, and
the scan length in the Y-axis. To set the appropriate scan length in the Y-axis, keep in
mind that the Spyne coverage is approximately 200 mm (8 in). Thus, a scan length of
1200 mm (48 in) in the Y-axis will yield a raster scan of 6 passes.
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Note that with the Spyne, the raster scan needs to be done in a clockwise orientation
(from left to right, Figure 16). As a result, in Magnifi, the first pass will always be
displayed at the top of the C-scan.

To perform a raster-scan acquisition:

) Null the probe © on a clean section of the component being inspected (as
much as possible free of visible defects, corrosion, etc.)

) Place the Spyne on its start position (Figure 12)
1) Start the acquisition and roll the Spyne axially along the surface to inspect

V) Take the Spyne off the surface and place it at its start position for the next
pass =
V) In the Home tab, click on Next Pass pe

VI) Repeat steps Ill, IV and V for every pass of the raster scan

VII)  Stop the acquisition

All these actions can also be performed directly with the Spyne keypad (see section 8c).
o=

evious

. Pr . o
The Previous Pass button r= can be used to re-acquire a previous pass.

Figure 18. Example of raster-scan data file, which each pass displayed in a single C-scan.

When analyzing large raster scan data, it may be helpful to switch to a layout with a
single C-scan instead of two. This can be done by clicking on Layout = Select. This will
double the size of the windows and remove the horizontal white lines in the C-scan.
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For the full 360° coverage of a pipe in a single raster scan, the table below helps to
evaluate the maximum axial scan length allowed, based on the pipe diameter. The
values are based on an overlap of 13 mm (%2 in) between each pass.

. . Number of . . Maximum axial scan length
Pipe outside Circumferential o .
. passes for full (X) for full 360° coverage in
diameter ° scan length (Y) .
360° coverage a single raster scan

6" 3 600 mm (24 in) 17 m (670 in)

8" 4 800 mm (32 in) 12.5 m (500 in)

10" 5 1000 mm (40 in) 10 m (400 in)

12" 6 1200 mm (48 in) 8 m (320 in)

16" 7 1400 mm (56 in) 7 m (280 in)

20" 9 1800 mm (72 in) 5m (200 in)

24" n 2200 mm (88 in) 4 m (160 in)

30" 13 2600 mm (104 in) 2.5 m (100 in)

36" 16 3200 mm (128 in) 2 m (80 in)

42" 18 3600 mm (144 in) 1.5 m (60 in)

48" 21 4200 mm (168 in) Tm (40 in)

To scan a larger surface than what is prescribed in the above table, multiple data files
will be required. Figure 19 shows two options to divide a large surface into multiple files.

Figure 19. a) Orientation-based division of the surface, with each data file covering the entire
length of the pipe and containing 4 passes (90°) of 8 meters; b) Length-based division of the
surface, with each data file covering the entire circumference of the pipe and containing 16
passes (360°) of 2 meters.
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The Spyne keypad can be used to facilitate the acquisition. Note that the Previous Pass
button is only active when using an Ectane and is not associated to any action on Reddy.

The red LED is currently unused. Work is undergoing to eventually use this LED as a real-
time alarm for the detection of indications.

Green LED
(Acquisition started)

Red LED
(Not used)

Start/Stop acquisition
Previous/Next pass for raster scan
Null

Figure 20. Spyne keypad

The data acquisition with the Spyne is subject to the following limitations:

o The maximum scan speed is limited to 600 mm/s (24 in/s). If the operator
wishes to limit the scan speed to a lower value, it can be modified in Setup =
Scan.

o As explained before, with the Spyne’s default scan resolution of 2 samples/mm
(50 samples/inch), the maximum scan length for a single pass is approximately
50 meters (2000 inches). For raster scans, the maximum scan length will
depend on the number of passes, as presented in the table above. Exceeding
this limit may cause incomplete data recording, error notifications or software
crashes upon starting the acquisition. Modifying the scan resolution will have
a direct effect on the maximum scan length: dividing the scan resolution by 2
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(1 sample/mm or 25 sample/inch) will double the maximum scan length
allowed (100 meters or 4000 inches), and vice-versa.

o The C-scans are built assuming a continuous and linear scan. While scanning,
make sure to roll the Spyne in a straight line, and to keep the encoder in
contact with the surface. Missing counts from the encoder will result in an
unscanned area and an inaccurate positioning of the indications.

o If the component being inspected doesn’t allow for the encoder to roll on a
straight surface, clock-based acquisition can be selected in Setup = Scan. In
this case, the scan speed needs to be kept as accurate and constant as possible
to allow locating the defects on the surface.

o If the encoder wheel wears out over time and its diameter changes, the
measured distance will become inaccurate. To workaround this issue, the
encoder can be calibrated as presented in section 12 of this user guide.
Alternatively, since the encoder is detachable, a new one can be purchased

from Eddyfi.

o The Spyne is designed to inspect relatively smooth surfaces with limited
irregularities. Irregularities such as axial and transverse welds, corrosion, sharp
bending, flanges, etc. can cause additional lift-off during the acquisition.
Depending on the orientation of the lift-off curve (section 5) and on the
adjustment of the detection threshold (section 6), this additional lift-off will
cause a certain loss of sensitivity.
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9. Analysis and reporting

9a. Indications display

Immediately after the acquisition is stopped, the C-scan will display yellow boxes
around all the indications detected, based on the signal threshold set previously (see
section 6 of this user guide).

Depending on the amount of overlap between each pass, indications located in the
overlapped area between two passes may have been duplicated: this is the price to pay
to make sure that no defect is left behind. For single-pass scans, these indications will
be present in two separate data files: near the top of the C-scan in one file, and near
the bottom of the C-scan in the next or previous file. For raster scans, the duplication
will be more obvious: two identical indications will be displayed side-by-side, on the
edges of two adjacent passes. Figure 21 below shows an example for a raster scan.

For the same reason, the Y position of an indication displayed in the C-scan will become
inaccurate due to the overlap. To locate an indication on the Y axis, its position within

a given pass should be used.

Figure 21. Duplication of an indication in the overlap area of a raster scan. The same indication
is displayed on the edge of two adjacent scan passes.
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9b. Indications merging criteria

Before adding all the indications to the report, it may be relevant to review the
boundary criteria for merging indications close to each other. For example, in most
situations, it would be irrelevant to report dozens of separate indications within a single
colony of cracks. Merging all these small indications into a single indication would be
more appropriate and would lead to a lighter report. This is also more consistent with
how visual inspection is performed. The boundary criteria for the X and Y axes can be
modified in the Detect Indications menu. By default, one sample in X corresponds to
0.5 mm (0.020"). For example, setting the X boundary criterion to 40 samples means
that two indications within 20 mm (0.80”) of each other in the X axis will merge
together. In the Y axis, one sample corresponds to 1.6 mm (0.063") for probes with 66
coils, and to 1.2 mm (0.047") for probes with 86 coils.

Boundary
Increase X axis by 1 smpl S
Increase Y axis by 1 smpl =

70 indications

Boundary
Increase X axis by 10 smpl =
Increase Y axis by is:n}l :V

16 indications

Boundary

Increase X axis by 20 smpl %

Increase Y axis by 4 smpl -
1 indication

Figure 22. Effect of the X and Y boundary criteria on the number of indications displayed in the
C-scans. Optimizing the boundary values will have a direct effect on the relevance of the report.

30|Page



Eddyfi
Technologies .

At any time during an inspection, the content of the report can be visualized and
modified in the Report tab at the bottom of the screen. If this tab is not displayed, first
make sure that Report is selected in the Layout menu.

Since the report format is often specific to the inspection procedure being followed, the
aim of this section is not to suggest a specific report format, but rather to present all
the tools available in Magnifi for building a report. All the following tools can be
accessed in the Analysis tab:

S

)‘)

o The Report Detections veeons button will add to the report every single
indication marked with a yellow box in the C-scan, based on the current
automatic detection threshold. The position and size (X and Y) of each
indication will be reported. This is where the boundary criteria presented in
section 9a becomes important: a report with 20 merged indications will be a
lot easier to consult compared to a report with 500 smaller indications all
gathered close to each other.

o>

. (%]

o Similarly, the Remove Detections peecions button will remove all these indications
from the report in one click.

s $
< <
o The Previous Preious and Next Net buttons are used to navigate between the

different indications in the C-scans, based on their position on the X axis. By
default, the keyboard shortcuts for Previous and Next are F7 and F8.

o If the automatic detection tools are not used or if additional indications need

to be added to the report manually, use the Add defect buttons at
the bottom of each Lissajous view. This will add a yellow indication box in the
corresponding C-scan, where the cursor is located. Additionnally to the X-Y
position of the indication, the amplitude (V) and phase (°) of the eddy current
signal measured in the impedance plane will also be reported. These indications
reported manually are independent from the automatic detection threshold,
and will not be removed from the report by clicking on Remove Detections. The
option to take a screenshot for every indication added manually is available in
the backstage: these screenshots can also be added to the report.

All indications, reported either automatically or manually, will all appear in the
same report.
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types of report format, available in the report’s | Name |Report.mdb =)
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Once the table profile has been selected, click on Generate Report‘

o Surface Screening: ideal format for the
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Mo
The No Defect peet button is used to tag a data file without any indication.

The Review FReview button is used to tag a data file for further review.

€9

Add
The Add Note Met= button creates a .txt file attached to the data file currently

loaded.

The Capture Capture button takes a .png screen capture attached to the data
file currently loaded.

| Take screenshot with report entry

indications reported with the automatic detection tools (i.e. the Report
Detections button). The screening report contains the position and size (X and
Y) of each indication.

Generic Array: ideal format for the indications reported manually (i.e. with the
Add defect buttons). The generic array report will contain the position (X and
Y), signal amplitude (V) and signal phase (°) of each indication.

Generate
Report

to generate

the report. After selecting the report options and filling out the information contained
in the report summary, the report will be displayed on the screen:

The first page contains the report summary;
The second page contains the defect table, with all the reported indications;

If indications were reported manually with screenshots, the screenshots will be
displayed at the end of the report.

The report can be exported into .pdf, .doc or .xIs format. The exported file will be saved
in the inspection folder, which can later be transferred through wi-fi or USB key by

clicking on Transfer Inspection.

Transfer
Inspection
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10. High-pass median filters

The high-pass median filter is a powerful tool that increases the signal-to-noise ratio of
ECA data and facilitates crack detection. However, if used the wrong way, it can filter
out certain defects and make them invisible in the C-scan. ”

Y
The high-pass median filter can be tuned in the Process menu pracess of the Setup tab.

The Index Axis value is used for two-dimensional median filters, which are rarely
beneficial for the detection of ——
surface-breaking defects such Median High Pass

as cracks and pittings. For this Index Axis (mm) Scan Axis (mm)

reason, the Index Axis should @‘_DO not modify Tunoble length

be kept to its default value.

The important tunable parameter of the high-pass median is the Scan Axis value. A
widely used rule of thumb is to set this value to three times the longest expected defect.
For example, in the presence of stress corrosion cracking colonies that can be as long
as 100 mm (4 inches) in the scan axis, a filter of 300 mm (12 inches) should be used.
Since it is often difficult to predict the size of the defects before an inspection, the
length of the median filter should initially be kept to a high value.

In summary, as displayed in Figure 23 below, an excessively long filter will not be as
efficient in removing the background noise, but an excessively short filter will remove
part of the signal from the defects.

After data has been acquired, clicking on Lift-off Assist. in the Calibration tab will
temporarily disable all median filters. This can be used as a quick on/off filter toggle.

Figure 23. Effect of the size of a high-pass median filter on data quality: a) no filter causes a
higher background noise (dark horizontal lines) and the smaller indications in the top right
corner being missed; b) an optimal filter size provides an enhanced signal-to-noise ratio for
indications of all sizes; c¢) a filter that is slightly too short removes parts of large indications
without affecting their detectability; d) a filter that is significantly too short removes most of
the indications and leads to defects being missed entirely.
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11. Detection of hard spots

A hard spot is an area of material that has experienced a local increase of hardness,
caused either by cold work or by quenching during the manufacturing process. Since
this localized hardening is associated with changes of the magnetic properties of the
material, the Spyne can be used to detect them efficiently.

Most of the content presented in this user guide still applies to the detection of hard
spots, with two extra steps required before beginning the inspection:

1) Change the color palette to Dark Rainbow;
2) Disable the high-pass median filters in the Process menu.

Hard spots indications are associated with a negative variation of signal amplitude in
both the axial and transverse channels, with a phase shift of approximately 180°
relatively to crack indications. Since the default color palette used with the Spyne offers
poor contrast for negative signals, it is highly beneficial to use an alternative color
palette such as Dark Rainbow (Magnifi 4.7) or Saw Tooth Rainbow (previous versions).
This can be done in the Palette menu of the Current View tab.
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Figure 24. Two distinct hard spots displayed in blue by using the Dark Rainbow color palette.
The C-scan cursor shows the hard spot’s negative signal signature in the Lissajous window.
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Figure 25. Small colony of SCC in the middle of a hard spot: the Dark Rainbow palette displays
the SCC in orange (positive impedance signal) and the hard spot in blue (negative signal).
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It is also important to have a good understanding of the high-pass median filters
presented in section 10, since the size of a hard spot can be significantly larger than
most colonies of cracks. As a result, a median filter of small size can remove entirely a
hard spot from the C-scans. For the detection of hard spots, it is good practice to
initially disable the high-pass median filter, and enable it only during the analysis phase
with a size adjusted based on the hard spots indications that were detected.

Refer to section 10 for more details on the high-pass median filter.
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Figure 26. Oval-shaped hard spot indication of approximately 530 mm by 150 mm (21 in by 6
in) displayed with a) an extra-long high-pass median filter of 2500 mm (100 in) and b) the
default median filter used for SCC detection, with a size of 250 mm (10 in). In the second case,
most of the hard spot signature is removed by the filter.

Finally, to add a hard spot indication to the report, the indication code HS (hard spot)
can be used instead of the standard CRK and COR (crack and corrosion) by holding the
Add defect button at the bottom of the Lissajous window. The indication codes can be
managed in the Indication menu of the Setup tab.
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If the encoder wheel wears in time, its diameter can change and affect the encoder’s
resolution. This will in turn affect the length measurement and positioning of indications,
and might distort the transverse C-scan (i.e. causing a straight transverse indication to
appear with a zigzag shape in the transverse C-scan).

To workaround this issue, a simple calibration can be performed to apply a correction
factor to the encoder’s resolution:

[)  Start an acquisition.

II)  Roll the Spyne in a straight line on a flat surface, and stop the acquisition. A longer
travel distance will lead to a more precise calibration.

[l1)  Measure the traveled distance precisely.

[+]
IV) In the Calibration menu, click on the Encoder -2\ calibration button.
V)  Enter the measured traveled distance and click Enter.

VI) Click Calibrate and click OK. The correction factor is now applied to the setup
configuration.
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